
hyperlin 
 
  

NJGIN Core 
Simple Documentation 

with the ArcGIS Pro Metadata Editor 
 

New Jersey Office of Information Technology 
Office of GIS 
njgin@oit.nj.gov 

Abstract 
 

The New Jersey Office of Information Technology, Office of GIS, 
publishes NJGIN Core as a brief and concise means to document 

shared authoritative geospatial content for the New Jersey GIS 
community via https://njgin.nj.gov 

 
January 2023 

Version 2.2 



NJGIN Core 
  

Page 2 of 18  19-Jan-23 

Contents 
 
About NJGIN Core .................................................................................................................................. 3 

Why Use ArcGIS Pro? ............................................................................................................................. 4 

Why Not Use ArcGIS Pro? ..................................................................................................................... 4 

Directions ................................................................................................................................................. 4 

Required Elements ................................................................................................................................ 8 

Optional Elements ............................................................................................................................... 10 

Appendix I: Topic Category definitions ........................................................................................ 11 

Appendix II: Detailed Help ................................................................................................................ 13 

Version History ..................................................................................................................................... 18 

 
  



NJGIN Core 
  

Page 3 of 18  19-Jan-23 

NJGIN Core: 
Simple Documentation  
with the ArcGIS Pro Metadata Editor (FGDC – CSDGM Style) 
 

About NJGIN Core 
 
https://geoapps.nj.gov/njgin/documents/MD_NJGIN_core_AGO_Pro.pdf 
 
(To use the ArcGIS Online metadata editor, see separate document  NJGIN Core with the ArcGIS Online 
Metadata Editor) 
 
The New Jersey Geographic Information Network (NJGIN) was founded by the NJ Office of Information 
Technology, Office of GIS (NJOGIS) in 2001 to facilitate the sharing of geospatial content in the New 
Jersey GIS community.  The focal point of the network is the website https://njgin.nj.gov, where 
information consumers can search for geospatial content and data stewards can share their 
authoritative geospatial content.  The search function makes use of Esri’s ArcGIS Online and Open Data 
platform, including links to records on partner sites.  
 
Essential to sharing data sets is adequate documentation for each item to support discovery and 
assessment. To assist partner data stewards, NJOGIS publishes “NJGIN Core” as an abbreviated 
collection of elements. These can be entered using the ArcGIS Pro Metadata Editor, set to Style FGDC – 
CSDGM. These elements together answer the following questions: 
 

• Does a data set exist on a particular topic? 
• Does it exist for a particular location? 
• What is the temporal context of the data set? 
• Who can I contact to learn more about the data set? 
• Is it possible to access the data set now? 

 
NJGIN Core is software agnostic, except that ArcGIS Online requires ArcGIS format metadata. NJGIN 
Core metadata can be created most easily using ArcGIS Pro, ArcGIS Online, or ArcCatalog. 
 
Below is a list of the essential elements, described in further detail in the later sections of this 
document.  
 
•   Title •   Publication Date 

•   Description (Abstract) •   Summary (Purpose) 

•   Credits •   Status 

•   Keywords & Tags •   Location (geographic extent) 

•   Time Period of Content (temporal extent) •   Use Limitations 

•   Metadata date & language •   Point of Contact 

https://geoapps.nj.gov/njgin/documents/MD_NJGIN_core_AGO_Pro.pdf
https://geoapps.nj.gov/njgin/documents/MD_NJGIN_core_AGOL.pdf
https://geoapps.nj.gov/njgin/documents/MD_NJGIN_core_AGOL.pdf
https://njgin.nj.gov/
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Why Use ArcGIS Pro? 
 
 The metadata editing function in ArcGIS Pro works smoothly 
 Information for more-complete metadata can be captured automatically by synchronizing 
 The entire metadata record can be reviewed in an easy-to-read stylesheet display 
 Metadata can be attached to the data and travel with it 
 Can add a custom thumbnail image 
 One-button export of ArcGIS xml or html – enables easy archiving of your collection 
 Publication to ArcGIS Online can be done seamlessly both for data and for its associated metadata 

Why Not Use ArcGIS Pro? 
 
 Software install (and license) is required 
 There are a few advanced metadata functions that cannot be performed easily in ArcGIS Pro as 

installed by default 
 Experience with the overall software is needed 

 

Directions 
 
 Set up an ArcGIS Pro project, using the Catalog template.  
 Configure the project to view/edit ArcGIS metadata in style FGDC-CSDGM 

Go to Project -> Options -> Metadata and set to “FGDC CSDGM Metadata” 
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 If you want to avoid adding detailed automated processing steps to your metadata, check OFF that 
configuration (it may be ON by default): 
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 Configure the project to add the connections to data, using the Catalog pane  

 

 

 

 

 

 Switch the project to Metadata Editing mode 
 
 
 

 

 

1. Add connections to folders and 
databases here. If multiple panes are 
in use in Pro, you may first need to 
change tabs at the bottom of the Pro 
window 

2. Once connections have been 
added, they will be available here. 

3. Switch to Catalog tab 

4. Highlight 
feature class to 
work on                                             

5. Synchronize and/or Edit 
metadata 
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 Choose tool to use 
o Edit opens the metadata editor at the Item Description subsection. The ribbon changes to 

expose the Manage Metadata > Save button. 
o Import enables pulling existing metadata or a template into association with the active data. It 

will not completely over-write existing metadata, however. 
o Upgrade converts existing metadata in FGDC-CSDGM format to ArcGIS format, FGDC CSDGM 

style. 
o Export gives output as FGDC-CSDGM or ISO Standard xml. 
o Synchronize reads information out of the active data into the metadata record. 
o Save as creates standalone ArcGIS xml, with options to remove certain types of elements, or 

save the whole thing. Also can create nicely stylized html. 
 

 
 
 The ArcGIS Pro editor does not close after Save. Best practice – Save after completing each 

subsection. 
 Most of the required elements are in Overview and Metadata sections. It is perfectly acceptable to 

use additional elements. Don’t forget to update them when the Item changes. 
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 The required elements list ends on page 9, and optional elements list is on page 10. The balance of 
this document provides help information in more detail: listed elements have hyperlinks to the 
help.  

 Text below in bold shows Pro Metadata Editor headers. Stars  indicate data entry points. Check 
marks  indicate required entries that are captured automatically by synchronizing with the data. 
[Brackets] contain brief help information. 

Required Elements 
 
 Overview section 

Item Description subsection 
 Title 
 Tags  [Copy in all keywords after entry, described below] 
 Summary (Purpose) 
 Description (Abstract) 
 Credits [Include all organizations to show on Item page] 
 Use Limitation [Use Constraints and legalese for Distribution Liability.] 
 Bounding Box [four bounding coordinates in signed decimal degrees] 
Topics & Keywords subsection   
 Topic Category [ISO Theme Keyword. Check on one; definitions are listed in Appendix I: 

Topic Category definitions] 
 Theme Keywords [separate each word or phrase with a comma or with a line break] 
 Place Keywords [Enter at least a fully qualified description of coverage area, e.g. Trenton, 

Mercer County, New Jersey] 
Citation subsection 
 Title [appears again here, no edit should be needed] 
 Dates -> Published [Be sure to update this date when any change is made to data] 
Citation Contacts subsection, first set of entries [Bring up forms for entries using Load a 
contact or New Contact] 
 Organization 
 Role [= Originator] 
Citation Contacts subsection, second set of entries 
 Organization 
 Role [= Publisher] 

  

 Metadata section 
 Details subsection  

 File Identifier [change for each revision] 
 Date Stamp [May fill in automatically; if not, should be changed.] 
 Language [Pick from list] 
Contacts subsection 

 Individual Name [optional] 
 Organization Name 
 Role [=Point of Contact]  
Contact Information sub-subsection 
 Enter full contact address information (all fields) 
 Phone [Include area code]  
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 Resource section 

 Details subsection 
 Status 
Extents subsection > Resource Extent first set if entries [repeatable]  

Geographic Extent [was filled in above in Item Description. If not, go back there; filling it in 
here will not work correctly] 

Extent subsection >  Resource Extent: create second set of entries, for Time Period of 
Content [Add by using + New Extent button] 
 Extent Description [Currentness Reference: enter Ground condition, Publication Date, or 

other description of how the dates relate to the data.] 
 Temporal Period Extent   

 Begin Date 
 End Date 

OR  
 Temporal Instant Extent 

 Date 
Distribution subsection [Fill out only if the data are available outside of ArcGIS Online/ Open 
Data, and/or if there is a charge for the data. Details below in Optional section.]  
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Optional Elements 
 
 For content that satisfies AGO validator and provides entries for Open Data Item interface, add the 
following: 
 
 Metadata section 
 Maintenance subsection 

 Update Frequency OR Custom Frequency [How often are the *metadata* updated?] 
 Resource section  

Extent subsection  
 add second instance of Resource Extent for Temporal Extent, even if the description is 

Publication Date. See above for Editor details. 
Maintenance subsection 
 Update Frequency OR Custom Frequency [How often are the *data* updated?] 

 
 If the data are available outside of ArcGIS Online, and/or if there is a charge for the data, or if you 
want to add references to online sources for related information or data (e.g. your organization’s web 
page,) add the following: 
 

 Resource section, Distribution subsection  
 Distributor sub-subsection 

 Contact [same format as Metadata Contact, but commonly different content] 
Ordering Process within Distributor 

 Fees 
 Monetary units 
 Ordering Instructions 

Distribution Format within Distributor 
 Format Name [Use a well-known entry if possible] 
 Format Version [number or date] 
 Specification [URL to format spec] 
 Information Content [Explanation of the service type or file type in words] 
 Decompression Technique [only if applicable] 

Digital Transfer Options within Distributor  
Online Resource within Digital Transfer Options 
 Linkage [For service layer URL or AGO Item or direct download] 
 Function [Pick from list if there is an appropriate entry]  

 
Digital Transfer Options sub-subsection 
 Online Resource within Digital Transfer Options 

 Linkage [For related web page or organization web page] 
 Name [Of linkage target] 
 Function 
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Appendix I: Topic Category definitions  

ISO 19115 Topic Category codes1: For all metadata records, include one of the following ISO 
Topic Category codes (text), which expresses the Primary Theme of the data set, map, service, or 
application. In the ArcGIS metadata, this entry is a check box. Numeric (three digit numbers as text) 
codes are provided for reference only. 
 
o Biota   002    for naturally-occurring flora and fauna, such as wildlife, biological sciences, ecology, 

wilderness, sea life, wetlands, habitats 
 

o Boundaries   003     for administrative and political boundaries, i.e. legal land descriptions 
 

o climatologyMeteorologyAtmosphere   004     for atmospheric processes and phenomena, such as 
cloud cover, weather, atmospheric conditions, climate change, precipitation 

 
o economy   005     for economic activities or employment, such as labor, revenue, commerce, 

industry, tourism, ecotourism, forestry, fisheries, commercial or subsistence hunting, exploration 
and exploitation of  minerals, oil, gas 

 
o elevation   006     for height above or below sea level, such as altitude, bathymetry, digital 

elevation models, slope, and products derived from the preceding 
 

o environment   007     for environmental resources, protection, and conservation, such as pollution, 
waste storage and treatment, environmental impact assessment, environmental risk, and nature 
reserves 

 
o farming   001     for agriculture and farming, including the rearing of animals or cultivation of 

plants. For example, irrigation, aquaculture, herding, pests and diseases affecting crops and 
livestock 

 
o geoscientificInformation   008     for geological, geophysical, and other earth science information, 

such as minerals, rock structure, rock composition, rock origin, earthquakes, volcanic activity, 
landslides, gravity, soils, permafrost, hydrogeology, erosion 

 
o health   009     for human health and disease, health services, human ecology, and safety, such as 

human disease, human illness, factors affecting health, hygiene, mental and physical health, 
substance abuse 

 
o imageryBaseMapsEarthCover   010     for base maps, such as land cover, topographic maps, 

classified and unclassified images. 
 

o intelligenceMilitary   011      for military bases, structures, and activities, such as barracks, 
training grounds, military transportation, military information collection 

 
o inlandWaters   012      for inland water features and drainage systems, such as rivers, glaciers, salt 

lakes, water use plans, dams, currents, floods, water quality, hydrographic charts 
 

o location    013     for positional information and services, such as addresses, geodetic networks, 
postal zones and services, control points, place names 

 
1 Derived from ISO Draft International Standard: Geographic information -- Metadata (ISO/DIS 19115), 
2001, Section B.5.27 MD_TopicCategoryCode<<CodeList>> (pp. 85-86) and Creating and Using 
Metadata Services, 2002, ESRI, Chapter 4 – Publishing metadata in ArcCatalog. Numeric domain codes 
are from https://geo-ide.noaa.gov/wiki/index.php?title=ISO_Topic_Categories. 



NJGIN Core 
  

Page 12 of 18  19-Jan-23 

 
o oceans   014     for features and characteristics of salt water bodies excluding inland waters, such 

as tides, tidal waves, coastal information, reefs 
 

o planningCadastre   015     for land use, such as zoning maps, cadastral surveys, land ownership 
 

o society   016     for characteristics of societies and cultures, such as natural settlements, 
anthropology, archaeology, education, traditional beliefs, manners and customs, demographic 
data, crime and justice, recreational areas and activities, social impact assessments, census 
information 

 
o structure   017     for man-made construction, such as buildings, museums, churches, factories, 

housing, monuments, and towers 
 

o transportation   018     for transportation networks, the means and aids for conveying people and 
goods, such as roads, airports, airstrips, shipping routes, tunnels, nautical charts, vehicle or vessel 
location, aeronautical charts, railways 

 
o utilitiesCommunication   019     for energy, water, and waste systems, and communications 

infrastructure and services, such as hydroelectricity, geothermal, solar, and nuclear sources of 
energy, water purification and distribution, sewage collection and disposal, electricity and gas 
distribution, data communication, telecommunication, radio, and communication networks. 

 
o extraTerrestrial for region more than 100 km above the surface of the Earth  

 
o disaster for information related to disasters. Examples: site of the disaster, evacuation zone, disaster-

prevention facility, disaster relief activities. 
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Appendix II: Detailed Help 
 
ArcGIS field 
and (CSDGM 
element)  

Required Pro Editor 
location 

Notes 

Title Y Overview > Item 
Description > 
Title 

This will show up in search results. Include enough 
information to distinguish from other entries. Alternate 
Title field can be used for a well-known abbreviation or file 
name. Here is an example of a good Title: Congressional 
District Boundaries for the State of New Jersey, 2012 - 
2022; unofficial, nj_munis - based 

Publication 
Date 

Y Overview > Item 
Description > 
Date > Published 

This date is required. Change the Publication Date of the 
item every time there is a discrete update. 

 (Citation 
Information > 
Online 
Linkage) 

Opt  Resource > 
Distribution > 
Digital Transfer 
Options > Online 
Resource > 
Linkage 

Add URL to more information about the data and / the 
responsible organization. Also good to fill out Description 
and Function, although these will not display in FGDC 
stylesheet in AGO. 

Citation 
Contact 
Originator 
(Originator) 

Y Overview > 
Citation 
Contacts > 
Contact > 
Organization 
AND Role = 
Originator 

Party responsible for defining the data set. A fully-qualified 
name should be used, starting with the main organizational 
unit and specifying down the hierarchy, followed by any 
well-known abbreviation. Example: NJ Department of 
Environmental Protection, Division of Information 
Technology, Bureau of Geographic Information Systems 
(NJDEP - DOIT - BGIS). 

Citation 
Contact 
Publisher 
(Publisher) 

. Overview > 
Citation 
Contacts > 
Contact > 
Organization 
AND Role = 
Publisher  

Party responsible for making the data set available. Use 
same format as for Originator. Also put in Credits if 
different from Originator. 

Description 
(Abstract) 

Y Overview > Item 
Description > 
Description 
(Abstract) 

Should be understandable to intelligent general reader, and 
convey the subject of the data set as well as other key 
information to help a potential user to assess it. 

Summary 
(Purpose) 

Y Overview > Item 
Description > 
Summary 
(Purpose) 

Business reason why the data were created, and/or 
anticipated suitable uses for the data. 

Credits Y Overview > Item 
Description > 
Credits 

Include (copy in) the Originator, add the Publisher if 
different, and add any other contributors of funding or 
work. This entry is displayed prominently in AGO Item. 
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ArcGIS field 
and (CSDGM 
element)  

Required Pro Editor 
location 

Notes 

Status 
(Progress) 

Y Resource > 
Details > Status 

Complete if data set covers all the intended area & time, 
even if updates are ongoing; In Work if published as a 
partially-completed release; Planned if contemplated, or in-
progress but not published yet.  

Topic 
Category (ISO 
Theme 
Keyword) 

Y Overview > 
Topics and 
Keywords > 
Topic Categories 

Check on one, or if necessary, two. Definitions are 
provided in Appendix I. 

Tags Y  Overview > Item 
Description > 
Tags 

Will contain any tags entered when first editing the 
metadata. Copy in all other keywords you have added. 
Separate with commas or line breaks. 

Theme 
Keywords 

Opt   Overview > 
Topics and 
Keywords > 
Theme Keywords 

List other subject keywords or phrases that others might 
use to search for the data. Separate with line breaks. 

Place Keyword Y Overview > 
Topics and 
Keywords > 
Place Keywords  

List keywords or phrases that might be used to search for 
the data. The first word or phrase should fully specify the 
geographic location: e.g., Trenton, Mercer County, New 
Jersey. 

Bounding Box 
(Bounding 
Coordinates) 
(4) 

Y  Oveview > Item 
Description > 
Bounding Box 

Each of four geographic coordinates is in signed decimal 
degrees; sign included only for negative. Sync with data will 
fill in automatically. If created manually, must be done in 
the Overview > Item Description section of the editor, not 
in Resource > Extents, although the entry will show up 
there too. Check in Pro metadata display – it should be 
labelled Bounding rectangle, and Extent used for searching. 
(“searching” does not show up in the editor, only in the 
stylesheet.)  

Temporal 
Extent (Time 
Period of 
Content) 
Date(s) 

Y, only 
required if 
different 
from 
Publication 
Date 

Resource > 
Extents > 
Temporal Period 
Extent >Begin 
Date/Time AND 
End Date/Time; 
OR Temporal 
Instant Extent > 
Date/Time 

Do not add this information to the same resource extent 
that describes the Geographic Extent (Bounding Box.) 
Create a new Extent section. For example, if the data were 
captured by a sensor in July, but not processed and 
published until September, an Extent should be used to 
specify the capture date(s.) If you need to express a range, 
use Temporal Period Extent > Begin Date and > End Date. 
If you need to express multiple specific dates, use multiple 
instances of Temporal Instant Extent > Date. 
 
Optional for minimal metadata if the data content date 
would be described as publication date. 
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ArcGIS field 
and (CSDGM 
element)  

Required Pro Editor 
location 

Notes 

Temporal 
Extent 
Description 
(Time Period of 
Content 
Currentness 
Reference) 

Y, only 
required if 
different 
from 
Publication 
Date 

Resource > 
Extents > Extent 
Description  

Fill this in for the same Resource Extent as the Temporal 
date(s.) Enter Ground Condition or another phrase, 
explaining how the time period of content relates to the 
data. If you know when the data matched the real world, 
use Ground Condition.  
 
Required by AGO validator 
 
Not needed for Geographic Extent (Bounding Box) 

Update 
Frequency 
(Maintenance 
and Update 
Frequency) 

Opt  Resource > 
Maintenance > 
Update 
Frequency OR 
Custom 
Frequency 

Please use As Needed only if there is a structured routine in 
place for change detection and update. Otherwise one of, 
Irregular, Unknown, or Not Planned is more appropriate. 
 
Required by AGO validator. 

Use Limitation 
(Use 
Constraints) 

Y  Resource > 
Constraints > 
General 
Constraints > 
Use Limitation 

Identical to Overview > Item Description > Use Limitation. 
No edits needed if filled in there. Enter limitations on use, 
requests or requirements for attribution, and any legal 
disclaimer required by your organization. For public data, 
suggested language that does not conflict with the NJ Open 
Public Records Act is in MD_AGOL_Item_help.pdf, Section II. 
Contents will be displayed prominently in AGO Items. 

Distribution 
(Distribution 
Information) 

Opt. If 
used, all 
listed 
under 
Distributi
on should 
be used. 

Resource > 
Distribution > … 

Needed only for Items distributed outside of ArcGIS 
Online/Open Data.  

  

https://geoapps.nj.gov/njgin/documents/MD_AGOL_Item_help.pdf
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Linkage Opt Resource > 
Distribution > 
Distributor > 
Digital Transfer 
Options > Online 
Resource > 
Linkage 

Preferably, an actionable internet address for the resource, 
such as a direct download or REST service endpoint. 
Alternatively, URL for the AGO Item. 

Function Opt Resource > 
Distribution > 
Distributor > 
Digital Transfer 
Options > Online 
Resource > 
Function 

For downloadable data, catalog access, etc; leave empty if 
nothing matches, e.g for live services. 

Format Name Opt Resource > 
Distribution > 
Distributor > 
Distribution 
Format > Format 
Name 

e.g. Esri map service – ArcREST; Shapefile; WMS; File geodatabase; 
Cached map tiles; Streamed features; etc. 

Format 
Version 

Opt Resource > 
Distribution > 
Distributor > 
Distribution 
Format > Format 
Version 

Enter a software version number or a date. If using a date, 
format as follows: 2019-04-08. 

Specification Opt Resource > 
Distribution > 
Distributor > 
Distribution 
Format > 
Specification 

URL to formal format specification. E.g. for shapefile: 
https://www.esri.com/library/whitepapers/pdfs/shapefile.p
df 

Information 
Content 

Opt Resource > 
Distribution > 
Distributor > 
Distribution 
Format > 
Information 
Content 

Verbal description of information delivered by the format. 
E.g. for shapefile: Nontopological geometry and attribute 
information for the spatial features in a data set. 

Decompression 
Technique 

Opt Resource > 
Distribution > 
Distributor > 
Distribution 
Format > 
Decompression 
Technique 

Name and specification for compression, only if applicable. 
E.g. for zip: ZIP;  
https://pkware.cachefly.net/webdocs/casestudies/APPNOT
E.TXT  

Distributor 
Contact 

Opt Resource > 
Distribution > 
Distributor > 
Contact > … 

Except for role, same instructions as for filling in Metadata 
Contact, except that an individual name rarely is 
appropriate. Organization and Contact Information may be 
different from the Metadata Contact. 

  

https://www.esri.com/library/whitepapers/pdfs/shapefile.pdf
https://www.esri.com/library/whitepapers/pdfs/shapefile.pdf
https://pkware.cachefly.net/webdocs/casestudies/APPNOTE.TXT
https://pkware.cachefly.net/webdocs/casestudies/APPNOTE.TXT
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Fees Opt Resource > 
Distribution > 
Distributor > 
Ordering Process 
> Fees 

If no charge, enter 0.00. 

Monetary 
Units 

Opt Resource > 
Distribution > 
Distributor > 
Ordering Process 
> Monetary Units 

Select correct units from list, e.g. “US Dollar.” Required 
even if Fee is 0.00. 

Ordering 
Instructions 

Opt Distribution > 
Distributor > 
Ordering Process 
> Ordering 
Instructions 

Verbal description of how to obtain access to the data or 
service. 

Metadata Date Y Metadata > 
Details > Date 
Stamp 

May autopopulate. Change, manually if necessary, 
whenever the metadata are changed. 

File Indentifier Opt Metadata > 
Details > File 
Identifier 

Automatic entry (button). If metadata are downloaded for 
re-use, delete the entry in the copy and replace it; in ArcGIS 
metadata xml, located at /metadata/mdFileID 

Metadata 
Language 

Y Metadata > 
Details > 
Language 

Pick from list. 

Metadata 
Contact 
Individual 
Name (Person) 

Y Metadata > 
Contacts > 
Contact Name 

Should be the name of someone who can answer questions 
about the metadata and the Item; or stable group contact 
information (see below) 

Metadata 
Contact 
Organization 
Name 

Y Metadata > 
Contacts > 
Contact 
Organization 
Name AND Role 
= Point of 
Contact 

Structure this the same way as Originator (see above), 
although it may very well be a different organization. 

Metadata 
Contact Email 
(Electronic 
Mail Address) 

Y Metadata > 
Contacts > 
Contact 
Information > 
Email 

  

Metadata 
Contact 
Address Type 

Y Metadata > 
Contacts > 
Contact 
Information > 
Address type 

For NJ State addresses, usually has to be postal OR 
physical, because the two zip codes are not the same. 

Metadata 
Contact 
Delivery Point 
(Address)   

Y Metadata > 
Contacts > 
Contact 
Information > 
Address 

Use only PO Box OR street address. 
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Metadata 
Contact City 

Y Metadata > 
Contacts > 
Contact 
Information > 
City 

Postal City 

Metadata 
Contact 
Administrative 
Area (State or 
Province) 

Y Metadata > 
Contacts > 
Contact 
Information > 
State 

Two-letter abbreviation may be used. 

Metadata 
Contact Postal 
Code 

Y Metadata > 
Contacts > 
Contact 
Information > 
Postal Code 

Zip code 

Metadata 
Contact 
Country 

Y Metadata > 
Contacts > 
Contact 
Information > 
Country 

 Pick from list. 

Metadata 
Contact Voice 
Telephone 

Y Metadata > 
Contacts > 
Contact 
Information > 
Phone 

Include area code. 

 
 

Version History 
 
Version 2.2  Minor editorial updates and a few optional elements added. 
Version 2.1  Updated and edited for use with ArcGIS Pro 
Version 1.1: Removed entries that are no longer required by the AGOL validator. Added fuller optional 
Distribution Information. Other minor editorial changes. 
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